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About this guide
This guide provides a general overview of SAP BusinessObjects Data Quality
Management, version for SAP NetWeaver MDM, as well as specific
information for installing and integrating this product into your SAP
environment.

Note:
Elsewhere in this guide and in other media, the product is called SAP
BusinessObjects Data Quality Management for SAP NetWeaver MDM.

Software requirements
This product operates with SAPNetWeaver Master DataManagement (MDM)
7.1 SP05 (or later service packs), and SAP BusinessObjects Data Services
XI 3.2 (12.2.0).

Assumed audience
This guide assumes that the people responsible for integrating and using
this product are experienced administrators and users of SAP NetWeaver
MDM. This guide does not explain basic operation of the SAP environment.
For questions about the SAP environment, consult the appropriate SAP
documentation or SAP technical support.

This guide also does not explain the operation of SAP BusinessObjects Data
Services. For specific questions about Data Services, consult the Data
Services documentation.

SAP NetWeaver MDM documentation
This product uses the SAP NetWeaver MDM Enrichment Controller to
integrate with SAP NetWeaver MDM. To install and use this product, you
should have access to the SAP NetWeaver MDM product documentation,
particularly the guide MDM Enrichment Architecture.
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This guide is available online here:
http://help.sap.com/saphelp_nwmdm71/helpda
ta/en/44/aa4122e9d57454e10000000a11466f/frameset.htm
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Installation overview
This section explains the procedures for installing this product. The full
installation consists of the following steps:
1. Install SAP BusinessObjects Data Services.
2. Install the files for SAP BusinessObjects Data Quality Management for

SAP NetWeaver MDM.
3. Configure DQMDMProxy.
4. Logging.
5. Create a new User.
6. Add a password in the Visual Administrator.
7. Configure MDM Server to use the Enrichment Adapter
8. Update the BOBJ schema in the MDM Enrichment Controller

Administration view.
9. Import XML schemas.
10. Import syndication and import maps.
11. Create a workflow.
12. Import ATL files and configure the job.
13. Publish real-time job as a Web Service.

The installation provides an ATL file that you must manually import to Data
Services, according to the instructions in the Data Services documentation.
The ATL file contains a sample job for real-time address cleansing. Based
on this sample job, you can create a customized Data Services job, with the
appropriately customized syndication and import maps, to fit your specific
business needs.

Install SAP BusinessObjects Data
Services

You must install SAP BusinessObjects Data Services before installing or
deploying other components of this product. You can find system
requirements and instructions for installing, configuring, and running SAP
BusinessObjects Data Services in the Data Services Installation Guide.

You must have SAP BusinessObjects Data Services running during the
remaining installation procedures of this product, and during its operation.
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Note:
As part of the installation of Data Services, you must download and install
both the Data Services Cleansing Package for the version of Data Services
you are installing and the Address Directories you have purchased. The
Cleansing Package is used by the Individual and Firm Cleansing jobs. The
Data Services address cleansing jobs use address directories to compare
address data.

Install the files for Data Quality
Management for SAP NetWeaver MDM

The installation routine of this product provides the license agreement for
your acceptance and then copies essential files to the target machine. It
does not make changes to your Data Services configuration, your SAP
NetWeaver MDM configuration, or your Windows Registry.

To run the installation routine, invoke setup.exe and follow the onscreen
instructions.

The installation routine uses the LINK_DIR environment variable set by your
Data Services configuration to determine the default location for the
installation of this product. You can change the default installation path and
specify a different path during the installation routine.

Configure DQMDMProxy
You must have installed and configured the Enrichment controller before
proceeding. As part of the Enrichment controller installation, relevant EAR
files are deployed, WebService Proxies are created and made available in
the Visual Administrator.

Log in to the Visual Administrator and verify that sap.com/DQMDMProxy is
available. You must configure DQMDMProxy to point to the BusinessObjects
Data Services server that you created as part of the installation of Data
Services.
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Logging
This product logs errors to the Category /Applications/DQMDMAdapter. It
handles tracing (debug) information by storing it in a Location at
com.sap.mdm.enrichment.DQMDMAdapter. You can configure aspects of
logging through the Log Configurator in the Visual Administrator. See the
SAP NetWeaver MDM documentation for details of using the Log
Configurator.

Create a new User
You must add a new User, which will run the workflow to be created later in
these procedures.

To create a new User

1. From the SAP NetWeaver MDM Console, navigate to <repository>
> Admin > Users.

2. Add Enrich as a new user. The user ID must have sufficient privileges to
run workflows on the SAP NetWeaver MDM environment.

Add a user password in the Visual
Administrator

You must add a password for the new User in the Visual Administrator. For
instructions, see the documentation for the MDM Enrichment Architecture.

Configure MDM Server to use the
Enrichment Adapter

As part of the enrichment controller installation for SAP NetWeaver MDM,
the enrichment controller configuration file, MDM_EnrichmentController
Configuration.xml, is created. As part of the installation of this product,
you must edit this file to add some XML markup.
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The comments in the markup instruct you when to change values to allow
the markup to work with your configuration. If you used the name values
described in the installation procedures in this document, you need not make
changes to the attribute values in the markup. However, if you chose other
name values, you must place the corresponding values in the markup. These
tables show the values offered by the installation procedures.

ValueName

EnrichUser

EnrichmentEnrichmentProviderSystem code

Bobj_DQ_Address_CleanseEnrichmentServicePort code

Bobj_DQ_Address_CleanseWorkflow Name

Bobj_DQ_Address_CleanseWorkflow Step

ValueName

EnrichUser

EnrichmentEnrichmentProviderSystem code

Bobj_DQ_Firm CleanseEnrichmentServicePort code

Bobj_DQ_Firm CleanseWorkflow Name

Bobj_DQ_Firm CleanseWorkflow Step

ValueName

EnrichUser

EnrichmentEnrichmentProviderSystem code

Bobj_DQ_Individual CleanseEnrichmentServicePort code

Bobj_DQ_Individual CleanseWorkflow Name

Bobj_DQ_Individual CleanseWorkflow Step

In markup for the fileMDM_EnrichmentControllerConfiguration.xml,
you must replace these attributes with values that describe your environment.
You can edit the file in any XML editor.
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Value in this
markup to re-
place

Attribute

MDS_NAMEMDS Server name (the port number is required only if it is
different from the default MDS port)

MDSS_NAMEMDSS Server Name

MDIS_NAMEMDIS Server Name

REPOSITO-
RY_NAME

Repository name

After you make the required changes to the XMLmarkup, save MDM_Enrich
mentControllerConfiguration.xml and restart Erichment Controller
activities from the Erichment Controller administration view. For more
information, refer to the Enrichment Controller documentation.

Update the BOBJ schema
You must next update the BOBJ schema for use with this product.

To update the BOBJ schema

1. From the MDM Enrichment Controller Administration, click "Update SAP
BusinessObjects Data Services Schema".

2. Select the required repository to be updated and click the button Update
Schema.

The BOBJ schema is updated.

Import XML schemas
The installation routine of this product copied the XML schemas to the location
you specified. You must now import the XML schemas to the target repository
using the SAP NetWeaver MDM Console.

The XML schemas are in the following files:
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DescriptionXML schema file

Request schema used to syndicate
MDMAddressdata out to BusinessOb-
jects Data Services

Bobj_DQ_Address_Cleanse_Re-
quest.xsd

Response schema used to import the
Address data response from Data
Services into MDM

Bobj_DQ_Address_Cleanse_Re-
sponse.xsd

Note:
If you create your own Data Services job, you must instead import the XML
schemas from that job instead of the schemas provided here.

To import XML schemas

1. From the SAP NetWeaver MDM Console, verify that the target repository
is not loaded.
The repository should still be unloaded from previous steps.

2. Navigate to <repository> > Admin > XML Schema.
3. Add a new XML schema to serve as the Request schema and name it

Bobj_DQ_Address_Cleanse_Request.
4. From the file management window, navigate to the machine and directory

of the files installed for this product and select Bobj_DQ_Ad
dress_Cleanse_Request.xsd.

5. Save the changes.
6. Add a new XML schema to serve as the Response schema and name it

Bobj_DQ_Address_Cleanse_Response.
7. From the file management window, navigate to the machine and directory

of the files installed for this product and select Bobj_DQ_Ad
dress_Cleanse_Response.xsd.

8. Save the changes.

Follow the same steps for the following XML schemas:
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DescriptionXML schema file

Request schema used to syndicate MDM Firmdata
out to BusinessObjects Data Services

Bobj_DQ_Firm_Cleanse_Re-
quest.xsd

Response schema used to import the Firm data re-
sponse from Data Services into MDM

Bobj_DQ_Firm_Cleanse_Re-
sponse.xsd

Request schema used to syndicate MDM Individual
data out to BusinessObjects Data Services

Bobj_DQ_Individu-
al_Cleanse_Re-
quest.xsd

Response schema used to import the Individual data
responsefrom Data Services into MDM

Bobj_DQ_Individu-
al_Cleanse_Re-
sponse.xsd

Syndication and import maps
You must import the syndication and import maps to your SAP NetWeaver
MDM system, and then set the maps for inbound and outbound ports.

Note:
The maps used here are for the sample Data Services jobs provided with
this product and are relevant only for MDM standard delivered content
customers and vendors. If you create your own Data Services job or do not
use the mentioned repositories, you must instead use the SAP NetWeaver
MDMSyndicator and Import Manager to create mappings appropriate to that
job.

To import the syndication maps

Note:
To import the syndication maps, the target repository must be loaded.

1. From the SAP NetWeaver MDM Syndicator, select File > New.
2. Create the following values for these options:
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ValueOption

XML SchemaType

EnrichmentRemote System

Bobj_DQ_Address_Cleanse_RequestXML Schema

EnrichmentRequestRoot

3. Select File > Import.
4. Navigate to the directory where the files for this product were installed

for your version of SAP NetWeaver MDM and select the file
Bobj_DQ_Address_Cleanse_Request_SynMap.syn. Click OK.

5. Save the map as Bobj_DQ_Address_Cleanse_Request_SynMap.

Follow the same steps for the following options:

ValueOption

XML SchemaType

EnrichmentRemote System

Bobj_DQ_Firm_Cleanse_RequestXML Schema

EnrichmentRequestRoot

ValueOption

XML SchemaType

EnrichmentRemote System

Bobj_DQ_Individual Cleanse_RequestXML Schema

EnrichmentRequestRoot

Related Topics
• Install the files for Data Quality Management for SAP NetWeaver MDM
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To import the main response import map

1. Run the SAP NetWeaver MDM Import Manager. On the startup dialog,
select XML Schema.

2. Create the following values for these options:

ValueOption

EnrichmentRemote System

Bobj_DQ_Address_Cleanse_ResponseXML Schema

EnrichmentResponseRoot

3. Select the file Bobj_DQ_Address_Cleanse_Response.xml from files
installed for this product.

4. Import the file Bobj_DQ_Address_Cleanse_Response_Im
portMap.xml. This file was installed as part of this product that are
appropriate for your version of SAP NetWeaver MDM.

5. Save the map as Bobj_DQ_Address_Cleanse_Response_ImportMap.

Follow the same steps for the following options:

ValueOption

EnrichmentRemote System

Bobj_DQ_Firm_Cleanse_ResponseXML Schema

EnrichmentResponseRoot

ValueOption

18 SAP BusinessObjects Data Quality Management, version for SAP NetWeaver MDM

Installation2 Syndication and import maps



ValueOption

EnrichmentRemote System

Bobj_DQ_Individual_Cleanse_ResponseXML Schema

EnrichmentResponseRoot

To import the country map

The purpose of the country map is to synchronize the country values returned
by Data Services with the country values already present in the SAP
NetWeaver MDM system. If country values are not mapped, SAPNetWeaver
MDM adds the missing countries to the country table upon encountering the
value.

1. Run the SAP NetWeaver MDM Import Manager. On the startup dialog,
select Excel.

2. For the Remote System, select Enrichment.
3. Select the file country_all.xls from files installed for this product that

are appropriate for your version of SAP NetWeaver MDM.
4. Import the file Bobj_DQ_Country_ImportMap.xml from the files

installed for this product.
5. Save the map as Bobj_DQ_Country_ImportMap.
6. After resolving any conflicts and setting the proper actions (if necessary),

execute the Import to update the country table.

To import the regions map

The purpose of the regions map is to synchronize the regions values returned
by Data Services with the regions values already present in the SAP
NetWeaver MDM system. If regions values are not mapped, SAPNetWeaver
MDM adds the missing regions to the regions table upon encountering the
value. Missing regions values are also automatically added to the regions
table through the Bobj_DQ_Regions_ImportMap at run time.

1. Run the SAP NetWeaver MDM Import Manager. On the startup dialog,
select Excel.
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2. For the Remote System, select Enrichment.
3. Select the file regions_all.xls from files installed for this product.
4. Import the file Bobj_DQ_Regions_ImportMap.xml from the files

installed for this product that are appropriate for your version of SAP
NetWeaver MDM.

5. Save the map as Bobj_DQ_Regions_ImportMap.
6. Verify the partitions. In the Source Hierarchy pane, navigate to

Regions_all.xls > Region_Data$ > Regions. In the "Partiions
Field/Value" tab, verify that the source partitions available fields are Code,
Regions_comb, and Unique_ID.

7. Verify the mappings. In the Source Hierarchy pane, navigate to
Regions_all.xls > Region_Data$ > Regions. In the "Map Fields/Value"
tab, verify that the source fields are mapped as follows.

Destination FieldName

CodeCode

NameRegions [Partition]

CountryRegions (Clone)

Remote KeyUnique_ID

8. After resolving any conflicts and setting the proper actions (if necessary),
execute the Import to update the regions table.

To set maps for inbound and outbound ports

With all the maps imported to the SAP NetWeaver MDM system, you now
set the maps for inbound and outbound ports.

1. From the SAP NetWeaver MDM Console, verify that the target repository
is not loaded.
The repository should still be unloaded from previous steps.

2. Navigate to <repository> > Admin > Ports.
3. Select the outbound port Bobj_DQ_Address_Cleanse_Request.

You previously set the parameters for this outbound port, except for the
Map field.
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4. Set the Map field to the syndication map you imported,
Bobj_DQ_Address_Cleanse_Request_SynMap.
The fields are now as follows:

ParameterField

Bobj_DQ_Address_Cleanse_RequestName

Bobj_DQ_Address_CleanseCode

OutboundType

EnrichmentRemote System

Bobj_DQ_Address_Cleanse_Request_SynMapMap

ManualProcessing Type

5. Follow the steps 1-4 above for outbound ports,
Bobj_DQ_Firm_Cleanse_Request and
Bobj_DQ_Individual_Cleanse_Request

6. Select the inbound port Bobj_DQ_Address_Cleanse_Response.
You previously set the parameters for this inbound port, except for the
Map field.

7. Set the Map field to the import map you imported,
Bobj_DQ_Address_Cleanse_Response_ImportMap.
The fields are now as follows:

ParameterField

Bobj_DQ_Address_Cleanse_ResponseName

Bobj_DQ_Address_CleanseCode

InboundType

EnrichmentRemote System

Bobj_DQ_Address_Cleanse _Response_Im-
portMap

Map

XML SchemaFormat

Bobj_DQ_Address_Cleanse_ResponseXML Schema

AutomaticProcessing Type
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ParameterField

1File Aggregation Count

YesBlock on Structural Excep-
tions

EmptyStatus

8. Follow the same steps for inbound ports Bobj_DQ_Firm
Cleanse_Response and Bobj_DQ_Individual Cleanse_Response.

9. Load the repository.

All configurations that take place within the SAP NetWeaver MDM Console
are complete.

Create a workflow
You must create a workflow within the SAP NetWeaver MDM Data Manager
to control the data quality operations that are performed by this product. This
section discusses creating a workflow with some requirements specific to
this product. However, you should consult your SAP documentation for full
instructions on creating a workflow within SAP NetWeaver MDM Data
Manager.

Note:
As an alternative to creating a new workflow, you could add the data quality
processes to an existing workflow. However, this section focuses on creating
a new workflow.

Create the workflow as you would create any SAPNetWeaver MDMworkflow.
At minimum, any workflow for this product requires at least one Enrichment
Controller step to trigger the enrichment process.

Example: Sample workflow

This sample workflow has the following steps: Start,
Bobj_DQ_Address_Cleanse, and Stop. Note that a workflow should be
created also for Firm and Individual services.
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Though you can give the process steps any name, the remaining installation
steps assume the names used in this example. If you use different names,
you must substitute those names for the examples used here.

Import theATL file and configure the job
The installation routine of this product copied the file DQ_MDM_Enrich.atl
to the location you specified. You must now import DQ_MDM_Enrich.atl into
BusinessObjects Data Services, which will make available the project
MDM_DQ_Enrich, which contains the job RTJob_MDM_DQ_Addr, which in
turn contains the dataflow DF_Realtime_DQ_MDM_Addr_discrete. Youmust
then configure this job before using this product by performing the following
tasks:
• Change the Root directory parameters
• Disable unpurchased address cleanse engines
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• Configure the test file locations

To import the ATL files

1. From the Data Services Designer with the desired repository open, click
Tools > Import from file.
A window opens for you to specify the file to import.

2. Navigate to the location of DQ_MDM_Enrich.atl, select the file, and click
Open.

3. Navigate to the location of DQ_MDM_Enrich_Substitutions.atl, select the
file, and click Open.
Data Services imports the files to the repository.

The project, jobs, and dataflows used by this product are now available in
Data Services.

To disable address cleanse engines

For this product to function properly, you must disable the address cleanse
engines for countries you did not purchase. From the dataflow
DF_Realtime_DQ_MDM_Addr_discrete:

1. Open the Global Address cleanse Transform.
2. Select the Options tab.

The address cleanse engines are displayed.

3. Disable the engine for every address cleanse engine you have not
purchased.

To set substitution paramater path

You must set the path for the substitution parameter
$$DQ_MDM_Sample_WorkDir. To set the path:

1. On the Canvas of the Data Services Designer, go toTools > Substitution
Parameter Configurations.

2. Change the path for the $$DQ_MDM_Sample_WorkDir parameter to the
correct path to the location of test files.
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For example, if default installation paths were used, the path set for this
parameter would be C:\Program Files\Business Objects\Data
Quality Mgmt for SAP NW MDM\DQ_MDM_MDMComponents\MDM71.

3. Click OK to save changes.

Publish real-time job as a Web Service
This section describes the procedure required for BusinessObjects Data
Services to publish the real-rime job as a Web Service.

The term “real-time” means that Data Services reacts to messages as they
are sent, performing predefined operations and responding appropriately.

For more information about real-time jobs andWeb Services in Data Services,
see the Data Services documentation.

To publish real-time job as a Web Service

This procedure requires that you set ervice names to correspond to real-time
jobs in Data Services. The following table shows the service names and jobs
for this procedure

JobService name

RTJob_DQ_MDM_AddrBobj_DQ_Address_Cleanse

RTJob_DQ_MDM_Firm_CleanseBobj_DQ_Firm_Cleanse

RTJob_DQ_MDM_Individual_CleanseBobj_DQ_Individual_Cleanse

1. From the Data ServicesManagement Console, navigate toAdministrator
>Real-Time Services and select the "Real-Time Services Configuration"
tab.

2. Click Add.
3. Set the service name to Bobj_DQ_Address_Cleanse.

The service name must be the same as the port code for the inbound
and outbound ports.

4. Click the Browse Jobs button, and select the corresponding real-time
job.
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5. In the "Service Provider" section of the screen, click Add.
6. Select Job Server.
7. Click Apply.
8. Click the "Real-Time Services Status" tab. Check the box for the Web

Service that you just added and then click Start to start the Web Service
job.

Note:
The page does not automatically refresh, so you must manually refresh
it.

The Web Service is now ready to be published on the Web Server.

9. On the Data Services Administrator, navigate toWeb Services >Web
Services Configuration.

10. From the drop-down list, select "Add Real_Time Service", and clickApply.
11. Select Bobj_DQ_Address_Cleanse and click Add.
12. Repeat these steps for the services Bobj_DQ_Firm_Cleanse and

Bobj_DQ_Individual_Cleanse.

The Web services are now deployed and available for use.
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Overview
After you have installed this product, you can run Data Quality Management
jobs as you would run any other jobs on SAP NetWeaver MDM. See your
SAP NetWeaver MDM documentation for information about running jobs in
SAP NetWeaver MDM.

This section describes issues that are specific to running this product on
SAP NetWeaver MDM.

Updating regions
The Region_lookup Query transform in the dataflow is responsible for
executing a custom function (CF_DQ_MDM_lookupRegion) to look up the
region string that is to be returned by the address cleansing dataflow.

If you make any changes to the function CF_DQ_MDM_lookupRegion, you
must coordinate those changes with the import mappings and key mappings
of SAP NetWeaver MDM.

To access this function, go to the Data Services Designer. On the left pane
of the canvas labeled as "Local Object Repository", choose the "Custom
Function" tab and double click on CF_DQ_MDM_lookupRegion. See the
SAPNetWeaver MDM documentation for details of the import mappings and
key mappings.

Adding fields to request and response
schemas

You may want to add fields to request and response schemas. This sample
markup shows how request and response schemas should be defined.

<?xml version="1.0" encoding="UTF-8"?>
<xsd:schema
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<xsd:annotation>
<xsd:documentation xml:lang="en">
XML Schema generated by Data Services
</xsd:documentation>
</xsd:annotation>
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<xsd:simpleType name="DIType-varchar-10">
<xsd:restriction base="xsd:string">
<xsd:maxLength value="10"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="DIType-varchar-60">
<xsd:restriction base="xsd:string">
<xsd:maxLength value="60"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="DIType-varchar-40">
<xsd:restriction base="xsd:string">
<xsd:maxLength value="40"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="DIType-varchar-20">
<xsd:restriction base="xsd:string">
<xsd:maxLength value="20"/>
</xsd:restriction>
</xsd:simpleType>

<!-- The section below represents how an xsd element
should

be defined for use with this product. -->

<xsd:element name="EnrichmentRequest" >
<xsd:complexType>
<xsd:sequence>
<xsd:element name="Record" maxOccurs="unbounded">

<xsd:complexType>
<xsd:sequence>
<xsd:element name="id" type = "DIType-varchar-20"/>
<xsd:element name="houseno" type = "DIType-varchar-

10"/>
<xsd:element name="street" type = "DIType-varchar-

60"/>
<xsd:element name="city" type = "DIType-varchar-40"/>

<xsd:element name="region" type = "DIType-varchar-
40"/>

<xsd:element name="zip" type = "DIType-varchar-10"/>

<xsd:element name="country" type = "DIType-varchar-
40"/>
</xsd:sequence>
</xsd:complexType>
</xsd:element>
</xsd:sequence>
</xsd:complexType>
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</xsd:element>

</xsd:schema>

To understand how not to define an xsd element block for use with this
product, compare the following block with the offset block of the previous
example. The content is fundamentally the same, but written in this style,
this markup will not work with this product.

<xsd:element name="Record">
<xsd:complexType>
<xsd:sequence>
<xsd:element ref="id" />
<xsd:element ref="houseno" />
<xsd:element ref="street" />
<xsd:element ref="city" />
<xsd:element ref="region" />
<xsd:element ref="zip" />
<xsd:element ref="country" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="EnrichmentRequest">
<xsd:complexType>
<xsd:sequence>
<xsd:element ref="Record" maxOccurs="unbounded" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="id" type = "DIType-varchar-20"/>
<xsd:element name="houseno" type = "DIType-varchar-10"/>
<xsd:element name="street" type = "DIType-varchar-60"/>
<xsd:element name="city" type = "DIType-varchar-40"/>
<xsd:element name="region" type = "DIType-varchar-40"/>
<xsd:element name="zip" type = "DIType-varchar-10"/>
<xsd:element name="country" type = "DIType-varchar-40"/>

After you have created the schemas, next create new XML schemas in Data
Services Designer. See the Data Services documentation for instructions on
creating XML schemas in Data Services.

You must replace the existing XML readers in the dataflow with the new XML
Source readers and Targets writers. Make sure that you “passthrough” the
added fields through the dataflow or use them in processing, or else data in
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those fields will not reach the target writer. Import these same schemas into
SAP NetWeaver MDM and use the import and syndication managers to map
the fields into and out of MDM.

Consideration for custom Data Services data flows

For any custom Data Services data flows you create to use with this product,
ensure that the final XML response (XML Message Target) transform has
these two check boxes unchecked:
• "Print Comment"
• "Include Schema Location"

For information on editing Data Services transforms, see the Data Services
documentation.

Importingmaps for customData Services
schemas

This section describes a recommended procedure for importing maps for
custom Data Services schemas. You can perform this procedure if you have
created a custom XML schema to output data from Data Services.

Note:
Make sure the custom schema follows the overall structure as defined in the
section “Adding fields to request and response schemas.” The root element
for the output schema in the Data Services dataflow must always be
EnrichmentResponse.

Related Topics
• Adding fields to request and response schemas

To import maps for custom Data Services schemas

1. From the Data Services Designer, open the dataflow you created with
the custom schema.

2. Double-click the XML Target Message transform.
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The XML Target Message transform opens.

3. Define the parameter XML test file, and check the box for "Delete and
re-create file".
This file will be used later to create the import map.

4. Define the XML test file for the XML Source Message transform. Usually
this file is the output of syndicating a few sample records using the SAP
MDM Syndication Manager, possibly using a custom Syndication map.

5. From the Data Services Designer, navigate to Debug > Execute to run
the real-time job.
The job executes using data from the test file defined for the XML Source
Message transform. This data is sent through the dataflow and the result
of the processing is written to the location specified in the XML Target
Message transform.

6. Use the XML file created by the XML Target Message transform as a
sample for the SAP MDM Import Manager.

7. Map the fields to appropriate fields in SAP MDM's table and save the
map.

8. When you have finished all modifications to the dataflow, delete and
recreate theWeb Service using the Data Services Management Console.
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